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This guide provides all the information you need to get started in
preparing for Adobe Certified Expert (ACE) exams. Passing ACE exams
demonstrates your proficiency with Adobe software products and
allows you to promote your expertise with customers and employers.
As an ACE, you can stand out from your competitors and be noticed.

ACE Frequently Asked Questions

What is an ACE? What are the benefits of being certified? What are the exams
like? Get all your ACE questions answered in a brief, to-the-point FAQ.

Four-Step Check List
Learn about the process for getting certified.

Step 1:  Choose your certification level.

Step 2: Register for your exam(s).

Step 3: Prepare for and take your exam(s).

Step 4: Read the ACE Agreement and join the Adobe Certified community.

Exam Topic Areas and Objectives

Review the test content—topic areas and objectives—for each product exam.
The topic lists will help direct your studies, so please review correctly.

Practice Exams
Review sample questions to get an idea of the types of questions that will
be on the exam. Note: Though helpful, these practice exams are not necessarily
representative of the difficulty of the questions that you will encounter on the
actual exam.
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What is an Adobe Certified Expert (ACE)?

An Adobe Certified Expert (ACE) has earned a certification created specifically
for graphic designers, Web designers, video professionals, system integrators,
value-added resellers, developers, or business professionals seeking recognition
for their expertise with Adobe products. By passing one or more ACE exams, you
become eligible to promote yourself to prospective clients as a highly skilled,
expert-level user of Adobe software.

What is the main benefit of passing ACE exams and becoming Adobe
certified?

Adobe certification is an industry standard in excellence that can be used

to demonstrate your product knowledge and expertise, and also serves as a
catalyst when finding a job or seeking a promotion. The Adobe Certified Expert
(ACE) and Adobe Certified Instructor (ACl) logos and credentials have been
created for self-promotional use by individuals who have met all requirements
of the Adobe certified Expert or Adobe Certified Instructor programs. Those who
have passed the tests may place certification logos on business cards, resumes,
Web sites, and other promotional materials.

What are ACE Specialist and ACE Master?
There are three levels of Adobe certification.

1. Single product certification: Recognizes your proficiency in a single Adobe
product. To qualify as an ACE, you must pass one product-specific exam.
Example: ACE, Adobe InDesign® CS

2. Specialist certification: Recognizes your proficiency in a specific medium:
Print, Web or Video. To become certified as a Specialist, you must pass the
exams on the required products listed below. Example: ACE Print Specialist
(with passing marks on the tests for Adobe InDesign, Adobe Acrobat®, and
either Adobe Photoshop® or Adobe Illustrator®)

Specialists must pass all required (R) exams and any one elective (E) within any
given certification track

Print Web Video
Specialist Specialist Specialist
Adobe InDesign R — —

Adobe GolLive or — R —
Macromedia Dreamweaver

Adobe Acrobat R E —
Adobe Photoshop E R R
Adobe lllustrator E E —
Adobe Premiere® — —
Adobe After Effects® — —
Adobe Encore DVD

m m X

Note: Exam requirements are subject to change.
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3. Master certification: Recognizes your skills in terms of how they align with
the Adobe product suites. To become certified as a Master, you must pass
the exam for each of the products in the suite. Example: ACE, Creative Suite
Master (with passing marks on the tests for Adobe Acrobat, Adobe GolLive,
Adobe lllustrator, Adobe InDesign, and Adobe Photoshop)

What is an Adobe Certified Instructor (ACI)?

An Adobe Certified Instructor (ACI) is an ACE who provides instruction on Adobe
products. ACls must have an instructor qualification (a teaching credential,
passed the CompTIA CTT+ (http://www.comptia.org/certification/ctt/) or
equivalent), in addition to passing one or more ACE exams. For more information
visit the ACl home page, http://www.adobe.com/support/certification/aci.html

How do | prepare for an ACE Exam?

The keys to preparing for an ACE exam are experience with the product

and studying this Exam Preparation Guide (http://partners.adobe.com/asn/
programs/trainingprovider/aceexams/index.jsp). To access online training, user
guides, and many other study materials, visit Adobe’s training resources page
(http://www.adobe.com/misc/training.html). The following resources may also
help you prepare for your ACE exam:

«  Adobe product user guides
«  Adobe Press books

«  Adobe Authorized Training Centers (find the AATC nearest you through
the Adobe Partner Finder online at: http://partners.adobe.com/asn/
partnerfinder/search_training.jsp)

«  Adobe online training at www.adobe.elementk.com
«  Tutorials and materials from Total Training, at www.totaltraining.com

«  Other training resources online at www.adobe.com/misc/training.html

How do | get training?

Once you know what product you want to get certified in, use the Adobe Partner
Finder (http://partners.adobe.com/asn/partnerfinder/trainingprovider/index.
jsp) database to locate an Adobe Certified Instructor or an Adobe Authorized
Training Center in your area that teaches a class on the Adobe product you want
to learn. Contact them directly for more information about their classes and
registration details.

What are the benefits to becoming an ACE?

As an individual with an ACE, you can:

- Differentiate yourself from competitors

«  Getyour resumé noticed

-+ Attract and win new business

«  Gain recognition from your employer

+  Gettheinside track on Adobe’s latest offerings

« Leverage the power of the Adobe brand and resources

If you are an employer, use ACE as a benchmark so you can:
+  Find the right person for the job

«  Quickly assess candidate skill level

« Investin your most promising employees

« Increase productivity and efficiency
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What type of exam are the ACE exams?

Adobe ACE exams (which are administered by Pearson VUE and Thomson
Prometric, independent third-party testing companies) are computer-delivered,
closed-book tests consisting of 60 to 9o multiple-choice questions. Each exam
takes approximately one to two hours to complete, and results are given to you
at the testing center immediately after you complete the test.

How do I register for an ACE exam?
Contact Pearson VUE or Thomson Prometric by phone, on the Web, or in-person:

Pearson VUE Thomson Prometric

Register online WWww.pearsonvue.com www.2test.com

Register in-person Find a location online at Find a location online at

Wwww.pearsonvue.com www.2test.com

> P

o

What is the fee for the ACE exam?
Each exam is US$150 or local currency equivalent.

Soon after | passed an ACE exam, the exam was published for a new
product version. Do | have to successfully complete the new exam within
9o days?

No. You may continue to use the ACE logo and materials in accordance with the
Adobe Certified Program Guidelines for Logos and Credentials. When the exam
is published for the next version of the product you must successfully complete
that exam within 9o days to keep your ACE status current and continue using the
ACE logo and materials.

For example, you successfully completed the Adobe Photoshop 5.0 Product
Proficiency Exam; shortly thereafter, the Adobe Photoshop 6.0 Product
Proficiency Exam is published. If you choose not take the Adobe Photoshop 6.0
Exam, you may continue to use the ACE logo and materials. When the Photoshop
7.0 Product Proficiency Exam is published you must successfully complete

that exam with 9o days in order to continue to use the ACE logo and materials.
Otherwise, you would have to cease using the ACE logo and materials; however,
you could continue to use text references only to your Adobe Photoshop 5.0
certification.

What can | expect from Adobe if | pass the ACE exam?

As soon as you pass the exam, your name and exam results are given to us by
Pearson VUE or Thomson Prometric, our worldwide test administrators. Your
exam data is then entered into our database. You will then be sent an ACE
Welcome Kit and access to the ACE logo. You are also placed on our certification
mailing list to receive special Adobe announcements and information about
promotions and events that take place throughout the year.

How long does it take to receive my Welcome Kit?

You can expect your Welcome Kit to arrive four to six weeks after we receive
your exam results.
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STEP 1: Choose your certification level

There are three levels of certification to become an Adobe® Certified Expert.
Choose the one that’s right for you.

Single product certification: Recognizes your proficiency in a single Adobe
product. To qualify as an ACE, you must pass one product-specific exam.

Example: ACE, Adobe InDesign® CS

Specialist certification: Recognizes your proficiency in a specific medium:
print, Web, or video. To become certified as a Specialist, you must pass the
exams on the required products listed below.

Example: ACE Print Specialist (with passing marks on the tests for Adobe
InDesign, Adobe Acrobat® and either Adobe Photoshop® or Adobe Illustrator®)

Master certification: Recognizes your skills in terms of how they align with
the Adobe product suites. To become certified as a Master, you must pass

the exam for each of the products in the suite.

Example: ACE, Creative Suite Master (with passing marks on the tests for
Adobe Acrobat, Adobe GolLive®, Adobe lllustrator, Adobe InDesign, and Adobe

Photoshop)

Specialists must pass all required (R) exams and any one elective (E) within any

given certification track

Print Web Video
Specialist Specialist Specialist
Adobe InDesign R — —
Adobe GolLive or — R —
Macromedia Dreamweaver
Adobe Acrobat R E —
Adobe Photoshop R R
Adobe lllustrator E —
Adobe Premiere® — — R
Adobe After Effects® — — E
Adobe Encore DVD E
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Note: Exam requirements are subject to change.

STEP 2: Register for your exam(s)

Adobe ACE exams are administered by Pearson VUE and Thomson Prometric,
independent third-party testing companies. The tests are offered at more than
five thousand authorized testing centers in many countries.

To register for your ACE exam(s), contact Pearson VUE or Thomson Prometric by
phone, on the Web, or in person:

Pearson VUE Thomson Prometric
Register online www.pearsonvue.com www.2test.com
Register in-person Find a location online at Find a location online at
Www.pearsonvue.com www.2test.com

The ACE exam fee is US$150 worldwide.

STEP 3: Prepare for and take your exam(s

The keys to preparing for an ACE exam are experience with the product and
studying using the Exam Bulletin. To access online training, user guides, and
many other study materials, visit Adobe’s training resources page.

The following resources may also help you prepare for your ACE exam:

Adobe product user guides
Adobe Press books

Adobe Authorized Training Centers (find the AATC nearest you through the
online Adobe Partner Finder)

Adobe online training from Element K (http://adobe.elementk.com)
Tutorials and materials from Total Training (http://www.totaltraining.com)

Other online training resources

ACE exams are computer-delivered, closed-book tests consisting of 6o to 9o
multiple-choice questions. Each exam takes one to two hours to complete, and
results are given to you at the testing centerimmediately after you finish.

STEP 4: Sign the ACE Agreement and join the Adobe Certified community

Review the ACE Agreement prior to taking the exam. You will be asked to agree
to the ACE terms and conditions at the time of the exam.

Once you are ACE certified, visit the Adobe Certified community where you can:

Verify exam results

Get a copy of the ACE Agreement
Download your Adobe Certified logo
Find out about recertification
Connect with other Adobe certificants
Update your profile

Note: Information about the Adobe Certified Community is also printed on your
score report.
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EXAM TOPIC Exam Structure
The following lists the topic areas and percentage of questions delivered in
AREAS AND each topic argea. P P ? |
OBJECTIVES Topic Area % of # of
Exam Questions

General knowledge and features 8% 5
Viewing and navigating PDF documents 5% 3
Creating PDF documents 12% 7
Combining PDF documents 13% 8
Modifying and enhancing PDF documents 1% 7
Reviewing and commenting 11% 7
Managing document security 10% 6
Configuring Adobe PDF Settings 10% 6
Creating forms and collecting data 10% 6
Preparing PDF documents for print production 10% 6

Number of Questions and Passing Score
« 61 questions

«  77% minimum required to pass
Test Content: Topic Areas and Objectives
Following is a detailed outline of the information covered on the exam.
1. General knowledge and features
«  Describe the benefits and functionality provided by Acrobat Connect.
«  Describe the options available for customizing toolbars.

«  Describe the functionality provided to users of Adobe Reader by using the
Enable Usage Rights command.

«  Convert an Adobe PDF document to another format by using the File >
Export command.

«  Manage and modify PDF documents by using the Advanced > Document
Processing commands.

2. Viewing and navigating PDF documents
+  Explain how to access and use navigation features in a PDF document.
+  Use Find/Search to locate specific information in PDF documents.

+  Given a viewing tool, explain the purpose of or how to use that tool. (Tools
include: Zoom, Scrolling, Go To, Hand)

3. Creating PDF documents

Al
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List and describe the methods available for creating PDF documents.
(Methods include: From a Scanner, from a File)

Create a PDF document by using Adobe PDF Printer.
Create a PDF document by using Adobe PDFMaker.
Create a PDF document by using Acrobat Distiller

Combining PDF documents

List and describe the options available for combining files. (Options include:

merging files into a single PDF document, assembling files into a PDF
Package, creating PDF packages in Microsoft Outlook and Lotus Notes,
identifying differences between the Windows and Mac platforms)

Manage how files are combined and optimized by using the Combine Files
dialog box.

Incorporate headers, footers, watermarks and backgrounds to a PDF
document.

Attach files to a PDF document.
Modifying and enhancing PDF documents

Explain how to modify PDF documents by selecting options from the
Document menu.

Given a tool on the Advanced Editing toolbar, explain how to use that tool.
(Tools include: Link, Crop, TouchUp Text, TouchUp Object, Movie, Sound)

Create and modify bookmarks.
Rearrange and number pages by using the Pages panel.

Given a scenario, optimize the size of a PDF document by using the PDF
Optimizer.

Reviewing and commenting

Given a scenario, describe the methods available for conducting a review,
and when you would use that method.

Conduct and manage reviews by using the Review Tracker.

Explain how to set up an E-mail review of an Adobe PDF document.
Explain how to set up shared review of an Adobe PDF document.
Add comments to a PDF document.

Managing document security

List and describe methods that can be used to secure a PDF document by
using passwords

List and describe the methods available for creating and acquiring digital
signatures and certificates

Certify a document by applying a digital signature.
Secure documents by creating a security envelope.

Describe the functionality provided by Adobe LiveCycle Policy Server for
encrypting PDF documents.

Examine documents for and remove hidden data by using the Redaction
commands.
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Configuring Adobe PDF Settings

Given a specific output requirement, choose the appropriate Adobe PDF
Setting.

Given a specific output requirement, create a customized Adobe PDF
Setting.

Creating forms and collecting data

Compare and contrast the functionality provided for creating forms by using
Adobe LiveCycle Designer versus using the Acrobat forms tools.

Explain the functionality provided by the Form Field Recognition features.

Compile and manage form data.

10. Preparing PDF documents for print production

List and describe the features and options made available through the Print
Production toolbar.

Given an option in the Output Preview dialog box, explain the purpose of
that option.

Given an option in the Preflight dialog box, explain the purpose of that
option. (Options include: execute a preflight profile, create a custom
preflight profile, create a preflight droplet)

Al
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PRACTICE EXAM

Try out these helpful practice
questions to get a feel for
the types of questions on the
ACE exam, but please note
that your performance here
does not indicate how you'll
do on the actual exam. To
fully prepare for the exam,
closely review the topic areas
and objectives in the Exam
Bulletin in this guide.
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5.3

5.4

Describe the benefits and functionality provided by Acrobat Connect.
Which task can be performed by using Adobe Acrobat Connect Professional 6?

A. Require the user of a PDF document to connect to a server so they can open
or continue to use PDF documents to which a security policy has been
applied

B. Manage file versions across Adobe Creative Suite applications including
Adobe Acrobat

C. Conduct real-time meetings where attendees can log into a Web-hosted
meeting space from their own computers

D. Control and synchronize color management for Acrobat and the rest of the
Creative Suite

Correct answer: C

Use Find/Search to locate specific information in PDF documents.

You want to locate words in your PDF document such that if you are searching
for the word hiking you would also find the words hikes and hiked. Which
command should you choose?

A. Edit > Search, and choose the Proximity option

B. Edit > Search, and choose the Stemming option

C. Edit > Find, and choose the Whole words only option

D. Edit> Search, and choose the Whole words only option
Correct answer: B

Create and modify bookmarks.

Which statement about bookmarks in a PDF document is true?
A. Bookmarks can activate an action.

B. Bookmark text can NOT be edited once created.

C. Deleting a bookmark deletes the associated text in the PDF.
D. You canadd a new bookmark regardless of security settings.
Correct answer: A

Rearrange and number pages by using the Pages panel.

You are moving a page by dragging its thumbnail in the Page palette. You held
the Option key down before you clicked on the page to drag it. What will happen
when you let go?

A. The page will jump to the end of the document
B. The page will return to its original position and become locked

C. The page will jump to become an even-numbered page if it was even to
start or become an odd numbered page if it had been odd-numbered

D. Acrobat will duplicate the page and place the duplicate where you let go ' ‘®

Adobe



ADOBE ACROBAT PROFESSIONAL 8.0

PRACTICE EXAM

Page 10

7.5

Correct answer: D

Given a scenario, describe the methods available for conducting a review,
and when you would use that method.

You want to get feedback on a PDF document from several people. Everyone has
access to a folder on an internal net—work. You would like everybody to see all
comments as they are added to the document. What should you do?

A. Export the PDF document to Word

B. Attach the PDF document for Email Review

C. Send the PDF document for Shared Review

D. Send the PDF document as an attachment to an email message

Correct answer: C

List and describe methods that can be used to secure a PDF document by
using passwords.

Which security feature can be activated by using password security?
A. Create locking signature fields

B. Specify which users have access to a PDF file

C. Limit the time duration users have access to a PDF file

D

Restrict any edits to a PDF document except for filling in form fields and
signing existing signature fields

Correct answer: D

List and describe the methods available for creating and acquiring digital
signatures and certificates.

Which type of signature attests to the contents of the document and allows the
signer to specify the types of changes allowed for the document??

A. approval signature
B. certifying signature
C. encrypted signature
D. third-party signature

Correct answer: B

Describe the functionality provided by Adobe LiveCycle Policy Server for
encrypting PDF documents.

Which security option requires the Adobe LiveCycle Policy Server?
A. Binding a document to a particular digital ID

B. Creating a security envelope for delivering the file

C. Auditing usage and attempts to access the document

D. Encrypting document meta-data, file attachments and contents

Correct answer: C
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8.2 Given a specific output requirement, create a customized Adobe PDF
Setting.
You are preparing a document for PDF/X compliance by creating a custom
Adobe PDF setting. Which setting is required?

A. Embed All Fonts
B. Allow Postscript XObjects
PRACTICE EXAM C. Object-Level Compression: Tags Only
D. Color Management Policies: Convert All Colors to sRGB

Correct answer: A

10.1 List and describe the features and options made available through the
Print Production toolbar.

You have a PDF document that is supposed to be two-color. The file produces
four plates, a black plate and three spot color plates. What should you do?

A. Convert the spot colors to process by using the Convert Colors tool
B. Use the TouchUp Object tool to convert the objects to a single spot color

C. Convert the project to RGB and use color management policies to adjust the
objects that are on the wrong plate

D. Alias the inks with the Ink Manager to reduce the total number from four to
two

Correct answer: D
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